MAXREFDES117#: HEART-RATE AND PULSE-OXIMETRY MONITOR

The MAXREFDES117# reference design is a low power, optical heart-rate module complete with integrated red and IR LEDs, and a power supply. This tiny board, perfect for wearable projects, may be placed on a finger or earlobe to accurately detect heart rate. This versatile module works with both Arduino and mbed platforms for quick testing, development and system integration. A basic, open-source heart-rate and SpO₂ algorithm is included in the example firmware.

The board features 8 sewing tap pads for attachment and quick electrical connection to a development platform.

As with all Maxim reference designs, the BOM, schematics, layout files, and Gerber files are all available from the Design Resources tab. In addition, boards are available for purchase.

Features

- Optical Heart-Rate Monitor and Pulse Oximetry Solution
- Tiny 12.7mm x 12.7mm (0.5in x 0.5in) Board Size
- Low Power
- Device Drivers
- Free Algorithm
- Example C Source Code For Arduino And mbed Platforms
- Test Data

Competitive Advantages

- Highly-integrated, small-size sensor
- Non-chest based heart-rate/SpO₂ detection
- Ultra-low power consumption

Applications

- Wearables
- Heart-rate monitor
- Pulse oximeter
Introduction

Wearable devices hold the potential to transform health and medical monitoring. Heart rate, specifically, provides tremendous insight into heart function and health, during both activity and rest. Innovation and development of both optical semiconductors and lower-power integrated circuits makes the transition to wearables possible. Until now, only large organizations, with deep development budgets, could deliver such advanced products.

MAXREFDES117# delivers the promise of wearable devices to all developers. This unique design measures both heart rate and pulse oximetry. MAXREFDES117# features the MAX30102 with integrated red and IR LEDs for heart-rate and SpO₂ detection. This configuration ideally detects heart rate and pulse ox on a person’s fingertip, earlobe, or other fleshy extremity. The small board size of 12.7mm x 12.7mm (0.5in x 0.5in) is ideal for wearable applications and may be stitched into fabric for immediate prototyping. Firmware is available for both Arduino and mbed platforms, enabling users to develop with virtually any platform. User needs to provide a 2V to 5.5V supply at the power input, perfect for virtually any battery or Arduino and mbed form-factor board.

The MAXREFDES117# design utilizes the heart-rate/SpO₂ sensor (MAX30102), an efficient, low-power step-down converter (MAX1921), and an accurate level translator (MAX14595). The entire design typically operates at less than 5.5mW when using with the example firmware. A block diagram of the system is shown in Figure 1.
System Diagram

![System Diagram](image)

*Figure 1. MAXREFDES98# reference design block diagram.*

The power requirement is shown in Table 1.

**Table 1. Power Requirement for the MAXREFDES117# Reference Design**

<table>
<thead>
<tr>
<th>Input Voltage (V)</th>
<th>Input Current (mA, typ)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2V to 5.5V</td>
<td>1.5mA (3.3V input)</td>
</tr>
</tbody>
</table>

Note: Controller board is powered separately

The MAXREFDES117# reference design is a PPG-based heart-rate and SpO2 monitor subsystem. The circuit utilizes the MAX30102 heart-rate/SpO2 sensor with integrated red and IR LEDs. The step-down converter MAX1921 converts the 2V to 5.5V supply input and generates the 1.8V rail for the heart-rate sensor. The MAX14595 level translator provides an interface between the heart-rate/SpO2 sensor and the controller board, which generally use a different logic level.
Detailed Description of Firmware

The MAXREFDES117# can be used with virtually any microcontroller that has I²C interface. The Arduino and mbed example firmware have been tested on the following development platforms:

mbed:
- Maxim Integrated MAX32600MBED#
- Freescale FRDM-K64F
- Freescale FRDM-KL25Z

Arduino:
- Adafruit Flora
- Lilypad USB
- Arduino UNO

Users may read sampled data, calculated heart rate and SpO₂ through a terminal program, allowing analysis on excel or any third-party software. The simple process flow is shown in Figure 2.

Figure 2. The MAXREFDES117# firmware flowchart.
The complete source code, including the heart rate/SpO2 algorithm, is provided to accelerate development. Code documentation can be found in the corresponding firmware platform files.

Heart rate accuracy varies depending on the chosen platform. The tested mbed platforms give more accurate heart-rate/SpO2 calculations than the tested Arduino platforms because the mbed platform controllers have more SRAM than the Arduino platform controllers. For the example firmware, mbed platforms store 5 seconds of samples collected at 100sps, while the Arduino platforms store 4 seconds of samples collected at 25sps.

SpO2 calculation is based on the equation shown below. However, determining the constants \( C_1, C_2, \text{ and } C_3 \) requires a comprehensive clinical study of pulse oximetry data from a statistically significant population set using this hardware. Such a clinical study is beyond scope of this design. Therefore, the calculated SpO2 value may have an error.

\[
\text{SpO2} = C_1 \times \text{AverageRatio}^2 + C_2 \times \text{AverageRatio} + C_3
\]

Where \( \text{AverageRatio} \) is the average ratio of IR and red LED readings. \( C_1, C_2, \text{ and } C_3 \) are constants.

Quick Start

**Required equipment:**

- Windows PC with a USB port
- MAXREFDES117# board
- 5 cables that can be used to connect the MAXREFDES117# with the controller board
- One of the supported mbed or Arduino controller boards listed above
- One USB cable that is compatible with the selected controller board

Download, read, and carefully follow each step in the appropriate MAXREFDES117# quick Start Guide:

▼ MAXREFDES117# mbed Quick Start Guide
▼ MAXREFDES117# Arduino Quick Start Guide
Lab Measurements

Equipment used:

- MAX32600MBED#
- Adafruit Flora
- Adafruit BlueFruit
- Polar H7 Bluetooth Smart Heart Rate Sensor
- Android tablet

**Figure 3** and **Figure 4** show how the MAXREFDES117 calculated heart rate compared to the Polar H7 chest strap. The data in Figure 3 were taken while the person was sitting still for 20 minutes. And the data in Figure 4 were taken while the person was walking at a normal speed for 20 minutes.

![MAXREFDES117# VS CHEST STRAP](image)

*Figure 3. For sedentary test, over 99% of the mbed + MAXREFDES117# heart rate data are less than 5 beats/min delta from the Polar H7 chest strap.*
Figure 4. For moving test, over 92% of the Arduino + MAXREFDES117# heart-rate data are less than 10 beats/min delta from the Polar H7 chest strap.

Quick Start

Required equipment:

- Windows PC with a USB port
- MAXREFDES117# board
- 5 cables that can be used to connect the MAXREFDES117# with the controller board
- One of the supported mbed or Arduino controller boards listed above
- One USB cable that is compatible with the selected controller board

Download, read, and carefully follow each step in the appropriate MAXREFDES117# quick Start Guide:

▼ MAXREFDES117# mbed Quick Start Guide

Quick Start: Required equipment:

- Windows PC with a USB port
- MAXREFDES117# board
- 5 pieces of wires to connect the MAXREFDES117# to the controller board
- One of the three supported controller boards (Maxim Integrated MAX32600MBED#, Freescale FRDM-KL25Z, or Freescale FRDM-K64F)
- One micro USB cable (for MAX32600MBED# and FRDM-K64F)
- One mini USB cable (for FRDM-KL25Z)
The reference design is fully assembled and tested. Follow the steps below to verify board operation:

2. Import the demo program from [https://developer.mbed.org/teams/Maxim-Integrated/code/RD117_MBED/](https://developer.mbed.org/teams/Maxim-Integrated/code/RD117_MBED/)
3. Connect the MAXREFDES117 to the controller board: For MAX32600MBED#

<table>
<thead>
<tr>
<th>MAX32600MBED# port</th>
<th>MAXREFDES117 port</th>
</tr>
</thead>
<tbody>
<tr>
<td>P26 SDL</td>
<td>SDA</td>
</tr>
<tr>
<td>P27 SCL</td>
<td>SCL</td>
</tr>
<tr>
<td>P20 SCK RX</td>
<td>INT</td>
</tr>
<tr>
<td>3.3V</td>
<td>VIN</td>
</tr>
<tr>
<td>GND</td>
<td>GND</td>
</tr>
</tbody>
</table>

4. For FRDM-K64F

<table>
<thead>
<tr>
<th>FRDM-K64F port</th>
<th>MAXREFDES117 port</th>
</tr>
</thead>
<tbody>
<tr>
<td>E25</td>
<td>SDA</td>
</tr>
<tr>
<td>E24</td>
<td>SCL</td>
</tr>
<tr>
<td>D1</td>
<td>INT</td>
</tr>
<tr>
<td>P3V3</td>
<td>VIN</td>
</tr>
<tr>
<td>GND</td>
<td>GND</td>
</tr>
</tbody>
</table>
5. For FRDM-KL25Z

<table>
<thead>
<tr>
<th>FRDM-KL25Z port</th>
<th>MAXREFDES117 port</th>
</tr>
</thead>
<tbody>
<tr>
<td>E0</td>
<td>SDA</td>
</tr>
<tr>
<td>E1</td>
<td>SCL</td>
</tr>
<tr>
<td>D1</td>
<td>INT</td>
</tr>
<tr>
<td>3.3V</td>
<td>VIN</td>
</tr>
<tr>
<td>GND</td>
<td>GND</td>
</tr>
</tbody>
</table>

6. Connect the controller board to the PC with a USB cable.
7. In the MBED compiler, click the button at the upper right hand corner to select the appropriate controller board.
8. Compile and download the resulting binary to your mbed platform.
9. Press the Upload menu item in the Sketch menu to upload the firmware to the Flora board.
10. Open Hyperterminal or a similar terminal program on the PC. Find the appropriate COM port and configure the connection for 115200, 8-N-1 with no flow control.
11. Put a finger on top of the U1 on the MAXREFDES117#, contact with an earlobe is also sufficient. Constant pressure yields the best result.
12. Press any key on the terminal program and the system will start the conversion.
13. From left to right, the first two column shows the data for red and IR LED receiver. Third and fifth columns show the calculated heart rate and SpO2 values. And the fourth and sixth columns show the validities of the heart rate and SpO2 calculations.

MAXREFDES117# Arduino Quick Start Guide
Quick Start

Required equipment:

- Windows PC with a USB port
- MAXREFDES117# board
- 5 cables with grabber clips on both ends.
- One of the three supported controller boards (Adafruit Flora, Lilypad USB, or Arduino UNO board)
- One micro USB cable (for Lilipad or Flora)
- One A to B USB cable (for Arduino UNO)

Procedure

The reference design is fully assembled and tested. Follow the steps below to verify board operation:

1. If Arduino IDE is not installed on the PC follow the [getting started guide](#) to install the Arduino IDE on the PC.

2. If Adafruit Flora board is selected as the controller board:
   - Follow the [Adafruit Windows Driver installation guide](#) to install the driver.
   - Follow the "Adafruit Arduino IDE setup guide" to install the Arduino IDE and support files for Adafruit Flora board.

3. Download the source code RD117_ARDUINO.zip file and unzip it in a desired location.

4. Double click the RD117_ARDUINO.ino to open the project in Arduino IDE.

5. Connect the MAXREFDES117 to the controller board: For Flora

<table>
<thead>
<tr>
<th>Flora port</th>
<th>MAXREFDES117 port</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDA</td>
<td>SDA</td>
</tr>
<tr>
<td>SCL</td>
<td>SCL</td>
</tr>
<tr>
<td>D10</td>
<td>INT</td>
</tr>
<tr>
<td>3.3V</td>
<td>VIN</td>
</tr>
<tr>
<td>GND</td>
<td>GND</td>
</tr>
</tbody>
</table>
6. For Lilypad USB

<table>
<thead>
<tr>
<th>Lilypad USB port</th>
<th>MAXREFDES117 port</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>SDA</td>
</tr>
<tr>
<td>3</td>
<td>SCL</td>
</tr>
<tr>
<td>10</td>
<td>INT</td>
</tr>
<tr>
<td>+</td>
<td>VIN</td>
</tr>
<tr>
<td>-</td>
<td>GND</td>
</tr>
</tbody>
</table>

7. For Arduino UNO

<table>
<thead>
<tr>
<th>Arduino UNO port</th>
<th>MAXREFDES117 port</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDA</td>
<td>SDA</td>
</tr>
<tr>
<td>SCL</td>
<td>SCL</td>
</tr>
<tr>
<td>10</td>
<td>INT</td>
</tr>
<tr>
<td>3.3V</td>
<td>VIN</td>
</tr>
<tr>
<td>GND</td>
<td>GND</td>
</tr>
</tbody>
</table>

8. Connect the controller board to the PC with a USB cable.
9. In the Arduino IDE, click on the **Tools** menu and make sure the appropriate board is selected.
10. Select the proper communication port in the **Tools** menu.
11. Press the **Upload** menu item in the **Sketch** menu to upload the firmware to the Flora board.
12. Open Hyperterminal or a similar terminal program on the PC. Find the appropriate COM port and configure the connection for 115200, 8-N-1 with no flow control.

13. Put a finger on top of the U1 on the MAXREFDES117#, contact with an earlobe is also sufficient. Constant pressure yields the best result.

14. Press any key on the terminal program and the system will start the conversion.

15. From left to right, the first two column shows the data for red and IR LED receiver. Third and fifth columns show the calculated heart rate and SpO2 values. And the fourth and sixth columns show the validities of the heart rate and SpO2 calculations.

All Design Files
Download All Design Files

Hardware Files:
Schematic
Bill of Materials (BOM)
PCB Layout
PCB Fab Package
PCB CAD (PADS 9.0)

Firmware Files:
Arduino Platform
mbed Platform